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Formatting Visualizations to
Look Great and Work Well

So far you have learned how to visualize data; but have just learned that is not enough. The
data needs to be presented in such a way that it makes a huge difference in the way it is
received and understood. As you move beyond making great discoveries and doing great
analysis, you need to look at formatting to present the story of the data. Formatting is more
than just making a data visualization look good.

Tableau's formatting options give you quite a bit of flexibility. Fonts, titles, captions, colors,
row and column banding, labels, shading, annotations, and much more can be customized
to make your visualizations tell a story effectively.

This chapter will cover the following topics:

Formatting considerations
Understanding how formatting works in Tableau
Adding value to visualizations

Formatting considerations
Tableau employs good practices for formatting and visualization from the time you start
dropping fields on shelves. Tableau 10 additionally introduces a wide variety of new fonts,
colors, and defaults that emphasize aesthetic appeal. You'll find that the discrete palettes
use colors that are easy to distinguish, fonts, grid lines are faint where appropriate, and
numbers and dates follow the default format settings defined in the metadata.
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The default formatting is more than adequate for discovery and analysis. If your focus is
analysis, you may not want to spend too much time fine-tuning the formatting until you
have moved on in the cycle. However, when you start to consider how you will
communicate the data to others, you will need to contemplate how adjustments to
formatting can make a difference in how well the data story is told.

Sometimes, you will have certain formatting preferences in mind when
you start your design. In these cases, you might set formatting options in a
blank workbook and save it as a template.

Here are some of the things you should consider:

Audience: Who is the audience and what is the need?
Setting: This is the environment in which the data story is communicated. Is it a
formal business meeting where the format should reflect a high level of
professionalism? Is it going to be shared on a blog to informally, or even
playfully, tell a story?
Mode: How will the visualizations be presented? You'll want to make sure rows,
columns, fonts, and marks are large enough for a projector or compact enough for
an iPad. If you are publishing to Tableau Server, Tableau Online, or Tableau
Public, then did you select fonts that are safe for the web? Will you need to use
the device designer to create different versions of a dashboard?
Mood: Certain colors, fonts, and layouts elicit different emotional responses.
Does the data tell a story that should invoke a certain response from your
audience? The color red, for example, may connote danger, negative results, or
indicate that an action is required. However, you'll need to be sensitive to your
audience and the specific context. Colors have different meanings for different
cultures and contexts. Red might not be a good choice to communicate negativity
if it is also the color of the corporate logo.
Consistency: Generally, use the same fonts, colors, shapes, line thickness, and
row-banding throughout all visualizations. This is especially true when they will
be seen together in a dashboard or even used in the same workbook. You can also
consider how to remain consistent throughout the organization without being too
rigid.
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All of these considerations will inform your formatting decisions. Think of formatting as an
iterative process. Look for feedback from your intended audience often and adjust as
necessary to make sure your communication is as clear and effective as possible. The goal of
formatting is to communicate the data more effectively.

Understanding how formatting works in
Tableau
Tableau uses default formatting that includes default fonts, colors, shading, and alignment.
Additionally, there are several levels of formatting you can customize, as shown in the
following diagram:

Workbook level: The following type of formatting comes under this category:

Workbook defaults: From the menu bar, navigate to Format | Workbook. The 
ability to set certain formatting as default for the workbook is new to Tableau 10.
Default field formatting: Using the drop-down menu on a field in the data pane,
navigate to Default Properties | Date Format or Default Properties | Number
Format. This sets the default format in Tableau's metadata and will be applied to
any view where custom formatting has not been applied.
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Story level: Navigate to a story tab and navigate to Format|Story (or
Story|Format) to edit formatting for story-specific elements. These include
options for customizing shading, title, navigator, and description.
Dashboard level: Dashboard-specific elements can be formatted. When viewing a
dashboard, navigate to Format|Dashboard (or Dashboard|Format) to specify
formatting for dashboard titles, subtitles, shading, and text objects.

Worksheet level: We'll consider the various options in the following section. The following
types of formatting are available for a worksheet:

Sheet formatting: This formatting includes font, alignment, shading, borders,
and lines.
Field level formatting: This formatting includes fonts, alignment, shading, and
number and date formats. This formatting is specific to how a field is displayed
in the current view. The options you set at a field level override defaults set at a
worksheet level. Number and date formats will also override the default field
formatting.
Additional formatting: Additional formatting can be applied to titles, captions,
tooltips, labels, annotations, reference lines, field labels, and more.
Rich text formatting: Titles, captions, annotations, labels, and tool tips all contain
text which can be formatted with varying fonts, colors, and alignment. This
formatting is specific to the individual text element.

Worksheet-level formatting
Let's start by considering worksheet level formatting. Before we specifically look at how to
adjust formatting, consider the following parts of a view as it relates to formatting:
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This view consists of the following parts which can be formatted:

Field labels for rows: Field labels can be formatted from the menu1.
(Format|FieldLabels...) or by right-clicking on them in the view and selecting
Format.... Additionally, you can hide field labels from the menu (Analysis|Table
Layout) and then uncheck the option for showing field labels or by right-clicking
on them in the view and selecting the option to hide. You can use the
Analysis|Table Layout option on the top menu to show them again if desired.
Field labels for columns: These have the same options as for rows, but may be2.
formatted or shown/hidden independently from the row field labels.
Row headers: These will follow the formatting of headers in general, unless you3.
specify different formatting for headers of rows only. Notice that subtotals and
grand total have headers. The subtotal and grand total headers marked a and b in
the preceding figure, are total row headers.
Column headers: These will follow formatting of headers in general, unless you4.
specify different formatting for headers of columns only. Note that subtotals and
grand totals have headers. The grand total header marked a column header.

 EBSCOhost - printed on 12/18/2023 7:18 AM via PURDUE UNIVERSITY GLOBAL. All use subject to https://www.ebsco.com/terms-of-use



Formatting Visualizations to Look Great and Work Well

[ 290 ]

Pane: Many formatting options include the ability to format the pane differently5.
from the headers.
Grand totals (column) pane: This is the pane for grand totals that can be6.
formatted at a sheet or column level.
Grand totals (row) pane: This is the pane for grand totals that can be formatted at7.
a sheet or row level.

Worksheet level formatting is accomplished using the format window, which will appear
on the left side, in place of the data pane. To view the format window, select Format from
the menu and then Font..., Alignment..., Shading..., Border..., or Lines...:

You can also right-click on nearly any element in the view and select
Format. This will open the format window specific to the context of the
element you selected. Just be certain to verify that the title of the format
window matches what you expect. When you make a change, you should
see the view update immediately to reflect your formatting. If you don't,
you are likely working in the wrong tab of the formatting window or you
may have formatted something at a lower level (for example, Rows) which
overrides changes made at a higher level (for example, Sheet).

 EBSCOhost - printed on 12/18/2023 7:18 AM via PURDUE UNIVERSITY GLOBAL. All use subject to https://www.ebsco.com/terms-of-use



Formatting Visualizations to Look Great and Work Well

[ 291 ]

You should now see the format window on the left. It will look similar to this:

Note the following key aspects of the formatting window:

The title of the window will give you the context for your formatting selections.
The icons on the top match the selection options of the Format menu. This allows
you to easily navigate through those options without returning to the menu each
time.
The three tabs, Sheet, Rows, and Columns allow you to specify options at a sheet
level and then override those options and defaults at a row and column level. For
example, you could make row grand totals have different pane and header fonts
than column grand totals (though this specific choice would likely be jarring and
is not recommended!)
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The field's dropdown in the upper-right corner allows you to fine-tune
formatting at a field level.
Any changes that you make will be previewed and result in a bold label to
indicate that the formatting option has been changed from the default (notice
how the font for the header under Total has been customized in the preceding
figure, resulting in the label text of the header being shown in bold.

Clearing formatting,there are three options for clearing the format are as follows:

Clear single option:In the format window, right click the label or control of any
single option you have changed and select Clear from the pop-up menu.
Clear all current options: At the bottom of the format window, click the Clear
button to clear all visible changes. This applies only to what you are currently
seeing in the format window. For example, if you are looking at Shading and the
Rows tab, and then click Clear, only the shading options you have changed on
the Rows tab will be cleared.
Clear sheet: From the menu, navigate to Worksheet | Clear| Formatting. You
can also use the drop-down from the Clear item on the toolbar. This clears all
custom formatting on the current worksheet.

The other format options (alignment, shading, and so on) all work very similarly to the font
option. There are only a few subtleties to mention:

* Alignment: This includes options for horizontal and vertical alignment, text
direction, and text wrapping.
* Shading: This includes an option for Row and Columns banding. The banding
allows for alternating patterns of shading that help to differentiate or group rows
and columns. Light row banding is enabled by default for text tables, but can be
useful in other visualization types such as horizontal bar charts as well. Row
banding can be set to different levels which correspond to the number of discrete
(blue) fields present on the Rows or Columns shelf.
Borders: This refers to the borders drawn around cells, panes, and headers. It
includes an option for Row and Columns dividers. You can see in the view, the
dividers between the departments. By default, the level of the borders is set based
on the next to last field on Rows or Columns.
Lines: This refers to lines that are drawn on visualizations using an axis. This
includes grid lines, reference lines, zero lines, and axis rulers. You can access a
more complete set of options for reference lines and drop lines from the Format
option on the menu.
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Field-level formatting
In the upper-right corner of the Format SUM(Sales) window is a little drop-down labeled
Fields. Selecting this drop-down gives you a list of fields in the current view and selecting a
field updates the format window with options appropriate for the field. Here, for example,
is the window as it appears for the SUM(Sales) field:
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The title of the format window will alert you to the field you are formatting. The options for
fields include font, alignment, shading, and number and date formats. The latter two
options will over-ride any default metadata formats. Selecting an icon for Font, Alignment,
and so on will switch back to the sheet level formatting. However, you can switch between
the tabs: Axis/Header and Pane.

Custom number formatting:
When you alter the format of a number you can select from several
standard formats as well as a custom format. The custom format allows
you to enter a format string which Tableau will use to format the number.
The format string allows for up to three entries, separated by semi-colons,
to represent positive, negative, and zero formats. Here are some examples
assuming the positive number 34,331.336000 and the negative number
-8,156.777700:

Notice how Tableau rounds the display of the number based on the format
string. Always be aware that numbers you see as text, labels, or headers
may have been rounded due to the format.

Also, observe how you can mix format characters such as the pound sign,
commas, and decimal points with strings. The preceding example would
give a label of "same" where a value of 0 would normally have been
shown.

Instead of using "up" or "down" as shown in the preceding example, you
could use a Unicode character, such as ▲ or ▼.

Selecting a predefined format that is close to what you want and then
switching to custom, will allow you to start with a custom format string
that is close.
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An additional aspect of formatting a field is specially formatting NULL values. When
formatting a field, select the Pane tab and locate the Special Values section, as shown in the
following screenshot:

Enter any text you would like to display in the pane (in the Text field) when the value of the
field is null. You can also choose where marks should be displayed. The Marks drop-down
gives multiple options that define where and how the marks for null values should be
drawn when an axis is being used. You have the following options:

Show at Indicator: This results in a small indicator with the number of nulls in
the lower right of the view. You can click the indicator for options to filter the
nulls or show them at the default value. You can right-click the indicator to hide
it.
Show at Default Value: This option displays a mark at the default location
(usually 0).
Hide (Connect Lines): This option makes sure that it does not place a mark for
null values, but it does connect lines between all non-null values.
Hide (Break Lines): This causes the line to break where there are gaps created by
not showing the null values.
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You can see these options in the following screenshot, with the location of two null values
indicated by a gray band:
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You'll notice that the preceding line charts have little circle markers at the location of each
mark drawn in the view. When the mark type is a line, clicking on the Color shelf opens a
menu that gives options for the markers. All mark types have standard options, such as
color and transparency. Some mark types support additional options, such as border and/or
halo, as shown here:

The Hide (Break Lines) or the Show at Indicator options work well in the preceding view
because those two options do not obscure the null values. However, the formatting only
helps with actual null values. These are the records that exist in the data, but have null,
indicating no value. However, there are no records for some dates in December. In that
case, the value isn't null, there isn't even a record of the data. Tableau still connects the lines
across those missing days, potentially making it difficult to tell that there are gaps. In that
case, consider enabling data densification (you can accomplish this by ensuring the Show
Missing Dates option is selected from the drop-down of the DAY(Order Date) field on
Columns and then adding certain table calculations such as Index() to the Detail of the
view).
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This causes Tableau to generate records of data for the missing dates and treat the values as
null:
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You can also use a bar chart as a visualization type that indicates the missing days more
clearly:
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Additional formatting options
Additional formatting options can also be accessed from the formatting window. These
options include:

A myriad of options for Reference Lines
Line and text options for Drop Lines
Shading and border options for Titles and Captions
Text, box, and line options for Annotations
Font, shading, alignment, and separator options for Field Labels
Title and body options for Legends, Quick Filters, and Parameters
Cell Size and Workbook Theme options

You'll find most of these fairly straightforward. A few options might not be as obvious:

Drop Lines: They appear as lines drawn from the mark to the axis and can be
enabled by right-clicking on any blank area in the pane of the view with an axis
and selecting Drop Lines | Show Drop Lines. Additional options can be
accessed using the same right-click menu and selecting Edit Drop Lines. Drop
lines are only displayed in the Tableau desktop and Reader but are not available
when a view is published to the Tableau server, online, or public.
Titles and Captions can be shown or hidden for any view by selecting Worksheet
from the menu and then selecting the desired options. In addition to standard
formatting, which can be applied to titles and captions, the text of a title or
caption can be edited and specifically formatted by double clicking, right-clicking
and selecting Edit, or by using the drop down menu for the title or caption(or the
drop-down menu of the view on a dashboard). The text of titles and captions can
dynamically include the values of parameters, values of any field in the view, and
certain other data and worksheet-specific values.
Annotations can be created by right-clicking on a mark or space in the view and
selecting Annotate and then selecting one of the following three types of
annotations:

Mark annotations are associated with a specific mark in the view. If
that mark does not show (due to a filter or axis range), then neither
will the annotation. Mark annotations can include a display of the
values of any fields that define the mark or its location.
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Point annotations are anchored to a specific point in the view. If
the point is not visible in the view, the annotation will disappear.
Point annotations can include a display of any field values that
define the location of the point (for example, the coordinates of the
axis).
Area annotations are contained within a rectangular area. The text
of all annotations can dynamically include the values of parameters
and certain other data and worksheet specific values.

You can copy formatting from one worksheet to another (within the same
workbook or across workbooks) by selecting Copy Formatting from the
Format menu while viewing the source worksheet (or select the Copy
Formatting option from the right-click menu on the source worksheet tab).
Then select Paste Formatting on the Format menu while viewing the
target worksheet (or select the option from the right-click menu on the
target worksheet tab).

This option will apply any custom formatting present on the source sheet
to the target. However, specific formatting applied during the editing of
the text of titles, captions, labels and tooltips is not copied to the target
sheet.

Adding value to visualizations
Now that we've considered how formatting works in Tableau, let's take a look at some ways
in which formatting can add value to a visualization.

Always ask yourself what the formatting adds to the understanding of the data. Is it making
the visualization clearer and easier to understand? Or is it just adding clutter and noise?

In general, try a minimalistic approach. Remove everything from the visualization that isn't
necessary. Emphasize important values, text, and marks while de-emphasizing those which
are only providing support or context.
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Consider the following visualization using all the default formatting:
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The default format works very well. But compare that with this visualization:

Both the preceding charts are showing sales by quarter, filtered to the office supplies
department. With the exception that the top view has the department field on Columns in
an attempt to make it clear that only office supplies sales are being shown, the field
arrangement for the two views is exactly the same. The first view uses default formatting.

Consider some of the customizations in the second view:

The Title has been adjusted to include the department name.
The Sales field has been formatted to be shown using a custom currency with
two decimal places and units of millions. This is true for the axis and the
annotations. Often a high-level of precision can clutter visualization. The initial
view of the data gives the trend and enough detail to understand the order of
magnitude. Tooltips or additional views can be used to reveal detail and
precision.
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The axis labels have been removed by right-clicking on the axis, selecting Edit
Axis, and then clearing the text. The title of the view clearly indicates that one is
looking at Sales. The values alone reveal the second axis to be by quarter. If there
are multiple dates in the data, you might need to specify which one is in use.
Depending on your goals, you might consider hiding the axes completely.
The gridlines on Rows have been removed. Gridlines can add a value to a view,
especially in views where being able to determine values is of high importance.
However, they can also clutter and distract. You'll need to decide, based on the
view itself and the story you are trying to tell, whether gridlines are helpful or
not.
The trend line has been formatted to match the color of the line. Additionally, the
confidence bands have been removed. You'll have to decide whether they add
context or clutter based on your needs and audience.
The lines, shading, and boxes have been removed from the annotations to reduce
clutter.
The size and color of the annotations have been altered to make them stand out.
If the goal had been to simply highlight the minimum and maximum values on
the line, labels might have been a better choice as they can be set to display at
only Min/Max. In this case, however, the lower number is actually the second
lowest point in the view.
Axis rulers and ticks have been emphasized and colored to match the marks and
reference line (axis rulers are available under the lines option on the format
window).

Formatting can also be used to dramatically alter the appearance of visualization. Consider
the following chart:
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This visualization is nearly identical to the previous view with the difference of shading
applied to the worksheet and the title. Additionally, fonts were lightened or darkened as
needed to show up well on a black background. Some find this format more pleasing,
especially on mobile devices. If the view is to be embedded in a website with a dark theme,
this formatting may be very desirable. However, you may find some text more difficult to
read on a dark background. You'll want to consider your audience, the setting, and mode of
delivery as you consider whether such a format is the best for your situation.

Sequential color palettes (a single color gradient based on a continuous
field) should be reversed when using a black background. This is because
the default of lighter (lower) to darker (higher) works well on a white
background where darker colors stand out and lighter colors fade into
white.

On a black background, lighter colors stand out more and darker colors
fade into black. You'll find the reverse option when you edit a color palette
using the drop-down menu on the legend, double clicking the legend, or
right-clicking the legend and selecting Edit Colors... and checking
Reversed.

Tooltips
Tooltips add a subtle professionalism to the visualizations but are an easily overlooked
aspect of visualizations as they are not always visible. Consider the following default tooltip
that displays when the end user hovers over one of the marks in the preceding view:

Compare it to this tooltip:
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The tooltip was edited using the menu option Worksheet | Tooltip, which brought up an
editor allowing for the rich editing of text in the tooltip:

This editor is similar to those used for editing the text of labels, titles, captions, and
annotations. Observe the Insert dropdown in the upper-right corner which allows you to
insert fields, parameters, and other dynamic values. In the text, these are enclosed as a tag.
You'll notice that the first tooltip included command buttons (keeping and excluding filters,
creating sets, groups, and viewing the data). You'll need to decide if the command buttons
add easy functionality or are distracting or confusing for your intended audience. The
functionality is always available to the end user via a right-click.

You can stop a tooltip from showing at all by unchecking the option in the
editor.

Summary
With an understanding of how formatting works in Tableau, you'll have the ability to refine
the visualizations you created in discovery and analysis into incredibly effective
communication of your data story. Always consider the audience, setting, mode, mood, and
consistency as you work through the iterative process of formatting. Look for formatting
that adds value to your visualization and avoid useless clutter. Next, we'll look at how it all
comes together in dashboards.
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